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Welcome to the CHEMCAD  

 
This tutorial provides basic input skills for operating CHEMCAD. CHEMCAD is a 

very easy program to learn, and the best way to master it is by using it. Here we provide a 

step-by-step description of how to solve the condensate stabilizer problem given below. The 

input procedure is simple and straightforward. It is designed to be intuitive for a chemical 

engineer familiar with the Windows environment. However, for the sake of clarity and for 

those new to Windows, a review of some of the basic rules for using CHEMCAD is given. 

BASIC STEPS  
The following ten basic steps are used to run a flow sheet simulation in CHEMCAD.  

• Starting a new job  

• Selecting engineering units  

• Creating a flow sheet  

• Selecting components  

• Selecting thermodynamics options  

• Defining the feed streams  

• Input equipment parameters  

• Running the simulation  

• Reviewing the results  

• Generating hardcopy output  

The steps do not have to be performed in this order nor do all of them have to be done for 

each flowsheet. All should be considered for each problem.  

There are a series of Help facilities available throughout the program. The bottom line of the 

screen provides a one-sentence description of the current highlighted item. The Help 

command provides access to the On-line Manual, which contains comprehensive technical 

information. The [F1] key provides context sensitive help (place the cursor in a specific field 

and press the [F1] key). Use of these help facilities will ease your way through the program.  

CHEMCAD is object oriented. Therefore, most input and editing can be done by double 

clicking or right clicking the object of the operation, as well as by using the menu commands.  

All stream and unit operations specifications (input) are accomplished using dialog boxes. 

These dialog boxes are context specific and employ some combination of character fields, 

combo boxes, choice boxes and check boxes.  
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A DESCRIPTION OF THE TUTORIAL PROBLEM  

 
The problem to be solved in this tutorial is illustrated in Figure 1 below. It is a condensate 

stabilizer plant. Gas enters the system with the feed conditions shown. It is our job to take 

this existing unit and determine new operating conditions and any necessary modifications. 

The design requirements are as follows:  

1. The cricondotherm (highest possible) dew point of the product gas must be 20º F or less.  

2. The stabilized condensate (Stream 9) must have maximum propane content of 1%.  

 

 

 

 

 

 

 

 

 

 

 

Figure 1 Condensate Stabilizer Feed:  

 

HX-1  

 

           HX-2  

 

Valve  

 

Stabilizer  

T = 75. F  P drop 1 = 5 psi        P drop = 5 psi  P out = 125 

psia  

12 stages  

P = 200. psia  P drop 2 = 5 psi           T out = -5 F                       Feed stage = 1  

N2 = 100.19 lb-mol/hr                                         Vap. Frac. (1) = 1.0  Bottom draw = 30 lb-moles/hr  

C1 = 4505.48  

                       Column P drop = 5 psi  

C2 = 514.00  

C3 = 214.00  

iC4 = 19.20  

nC4 = 18.18  

iC5 = 26.40  

nC5 = 14.00  

nC6 = 14.00 2 
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GETTING STARTED  

The first time you run CHEMCAD the Top Level Window will appear on your screen. Please 

maximize this window (that is, zoom it to fill in the screen) by clicking the Maximize button 

in the upper right hand corner of the CHEMCAD window. This will cause CHEMCAD to fill 

your screen and your display should look something like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

The top line is called the Title Bar. It contains the CHEMCAD logo and name on the left 

side, and the WINDOWS minimize, tile, and close buttons on the right side.  

The next line is called the Menu Bar. This bar contains the top-level 

commands for CHEMCAD. They are:  

File  

 

This command is used to define 

output formats, open jobs, print, 

and obtain general information 

about CHEMCAD.  

License  This command is used to configure 

license, update dongles, and 

authorize special licenses.  

View  This command enables the user to 

toggle the Tool bar and Status bar 

on and off.  

Help  This function allows the user to 

call the on-line Help facility.  



4 
 

 

STARTING A NEW JOB – THE SIMULATION WINDOW  
   Let’s start by opening a new job and giving it a job name. The File command is used for 

this. To open the File menu, click on the word File on the menu bar.  

Now choose the New Job option by clicking on it. 

 

 

 

 

 

 

 

 

 

The following dialog box will open:  

This dialog box is prompting you to enter a name and folder for the new job. Let’s use the 

name TUTOR1. Please enter this name in the field labeled File Name. Then close the dialog 

box by clicking the [Save] button. You will be taken into the main working window of 

CHEMCAD. 
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The major features of this window are labeled above as described below:  

The top line, called the Title Bar, now contains the CHEMCAD logo and the current job 

name, as well as, the minimize, title, and close buttons which are always present on the left 

side.  

The Menu Bar follows the Title Bar and consists of fifteen 

commands in addition to the Help command. These commands 

are:  

File                                       For file management and print control 

For file management and print 

control.  

Edit  For modifying various aspects of 

the flowsheet and its presentation. 

Edit functions include Redraw, 

Undo, Redo, Cut, Copy, Paste, 

Delete, Flip, and Rotate 90° among 

others.  

View  For controlling various display and 

drawing options.  

 

Fomat  For selecting engineering units, 

setting graphics options, and 

importing bit maps.  

Mode  To switch back and forth between 

the Flowsheet mode and the 

Simulation mode.  

ThermoPhysical For selecting components, K-Value 

method(s), and enthalpy method(s) 

for the current job, as well as, 

viewing and editing the 

CHEMCAD databanks; setting up 

distillation curves and defining 

solids.  

Specifications  For entering, editing, and 

manipulating stream and unit 

operations data. This may also be 

done by double clicking the stream 

or UnitOp directly on the 

flowsheet.  

Run  For running the simulations, as well 
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as for defining calculation order(s).  

Results  For reviewing calculated results.  

Plot  For displaying calculated results 

graphically.  

Output  For preparing reports and Process 

Flow Diagrams (PFD’s).  

Sizing  For performing sizing and rating 

calculations for various types of 

equipment.  

Tools  For performing various activities 

associated with simulation. These 

include data regression, CO2 – 

solids and hydrates prediction, 

TOD/COD calculations, and others.  

Window  For arranging windows and icons 

display.  

Help  For invoking the CHEMCAD help 

system.  

 

 

 

 

SELECTING ENGINEERING UNITS  

To select engineering units for this flow sheet, select the Format command either by 

pressing [ALT + M] or by clicking it with the mouse. The following menu will appear: 

 

 

 

 

 

 

 

 

Now select the Engineering Units option by clicking on it with the mouse. The following 

dialog box will appear: 
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The ENGLISH unit’s option is the default and is currently highlighted. You may change the 

engineering units system by clicking any one of the four buttons English, Alt SI, SI, or 

Metric, or you can change any unit individually by clicking on the individual item and then 

selecting from the list presented. For this tutorial we will use English engineering units, 

therefore just exit the dialog box by clicking the Cancel button. 

DRAWING THE FLOWSHEET 

 To draw the flow sheet you will be working with the flowsheet palette, which looks like this: 
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Please note the following about the flow sheet palette: 

The first box re-invokes the arrow cursor when needed.  

• The second box enables the user to rotate objects on the flowsheet.  

• The next five boxes (reading horizontally) enable the user to draw the indicated primitive 

on the flowsheet.  

· Box number eight, the "ab" box, is used to put text on the drawing.  

· Box number nine is for drawing process streams (streams must connect unit operations).  

· The remaining boxes each represent one of the unit operations in the CHEMCAD library.  

· Pointing to a box with the cursor will cause a small descriptive label to appear which will 

indicate what each box represents.  

· Pointing to a box and clicking with the left button of the mouse will activate the 

corresponding function.  

· Pointing to a box and clicking with the right button of the mouse will cause a sub-palette of 

icon options to be displayed. Right clicking again (on the same master palette box) will cause 

the sub-palette to disappear.  

· Multiple sub-palettes may be displayed simultaneously.  

· The master palette may be switched on and off using the View\Main Palette command, by 

selecting between the Flowsheet/Simulation options on the Mode command, or by selecting 

between the Simulation/Flowsheet options on the Change Mode combo box on the tool bar.  

· The size and shape of the main palette can be controlled using the View\Palette Settings 

commands.  

· On the icon display, inlets are indicated by small blue squares and outlets by small brown 

squares.  

Our purpose now is to set up the flowsheet topology. Creating a flowsheet is the process of 

placing unit operations icons on the screen, connecting them with streams, and then adding 

various graphical objects to enhance the drawing. All of these things may be done using the 

palette.  

 

Feed  

We will start by placing unit operations icons on the flowsheet. By convention, CHEMCAD 

requires that every stream come from a unit operation and go to a unit operation. Therefore, 

we must place a Feed icon on the flowsheet to serve as the "source" unit for the feed stream. 

This is a good place to start, so point to the Feed box like so: 
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Please follow the procedure given below:  

1. Right click the feed icon box. The Feed sub-palette will appear. Now right click the feed 

icon box on the main palette again. The sub-palette will disappear. This is how you call and 

close UnitOp icon sub-palettes.  

2. Now left click on the feed icon (on the main palette). The palette will disappear and a 

small, square box will appear on the screen. This is the cursor used to position and place 

UnitOp icons on the flowsheet.  

3. Move the cursor to a position that is approximately on the left center of the screen. Then 

left click the mouse. The feed icon will appear on the flowsheet and the palette will reappear.  

 
Notice that since we selected our feed icon from the main palette, the icon displayed is the 

same one displayed on the main palette. To choose a different feed icon we would have had 

to select from the feed icon sub-palette.  

This completes the placement of the UnitOp Feed.  

For purposes of instruction, let’s explore some of the options associated with the Feed icon.  

a. To move the symbol:  

 Place the mouse arrow on the icon.  

 Hold down the left button on the mouse. The four windows object boxes will appear.  

 With the left mouse button held down, drag the icon up about one-inch, then release 

the left button of the mouse. The icon position has been changed.  

 

b. It may be necessary to move the palette out of the way in order to have access to the icon. 

You can do this by clicking and dragging on the brown bar at the top of the palette.  

c. To view the object editing options: place the mouse arrow on the icon (on the flowsheet, 

not on the palette) and press the right button on the mouse.  
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d. To move or stretch an object: left click on the icon so that the four object boxes are 

displayed around the icon. Then click and drag on one of these boxes. The icon will grow or 

shrink according to the mouse movements.  

Now let’s place the two heat exchangers on the flowsheet. Please follow the procedure given 

below:  

1. Point to the heat exchanger box and let the cursor stay there until the message label 

appears. Using this label, make sure you are pointing to the heat exchanger box.  

2. Right click the box. The heat exchanger icon sub-palette should appear.  

3. Now point to the two sided heat exchanger icon as indicated below:  

 

 

Two-sided heat exchanger 

 

4. Left click on this icon. The palettes will disappear and the small, square cursor will 

reappear.  

5. Locate the cursor about one and a half- (1.5) inch directly to the right of the feed icon. 

Then left click again. The heat exchanger icon will be displayed on the flowsheet and the 

palettes will reappear.  

6. Now point to the icon for a horizontally oriented, one sided heat exchanger as indicated 

below  

 

One-sided heat exchanger 

 
7. Left click on this icon. The palettes will disappear and the small, square cursor will 

reappear.  
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8. Locate the cursor about one and a half- (1.5) inch directly to the right of the first heat 

exchanger icon. Then left click again. The heat exchanger icon will be displayed on the 

flowsheet and the palettes will reappear.  

9. Now close the sub-palette by right clicking on the heat exchanger icon box on the main 

palette.  

Your flowsheet should now look something like this: 

 

 

For convenience, move the palette to one side by clicking and dragging on the brown bar at 

the top of the palette.  

Now follow the procedure outlined above to place the flash tank and the valve unit 

operations on the screen: 

 

 

 



12 
 

 

For the condensate stabilizer itself we want to use a distillation column module. You might 

notice from the palette that there are multiple distillation modules available in CHEMCAD. 

An explanation of each of these options is given in the on-line Help manual. You can access 

this manual at any time by clicking the Help command on the menu bar. For now however, 

let’s accept that the module we want to use is the rigorous distillation model called Tower. 

This UnitOp is found on your palette as shown below: 

Tower 

Since we want to use a Tower icon that has a reboiler but no condenser we must use the sub-

palette to select the proper icon. Therefore, right click on the Tower icon box. The sub-

palette will appear. Select the Tower icon indicated below by left clicking on it. 

Now add it to the flowsheet: 
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Close the sub-palette by right clicking on the Tower icon box on the main palette.  

Finally, we must put three Product icons on the flowsheet, one for each product stream. The 

Product icon is located slightly to the right and down from the center of the palette as shown:  

 

 

When you are finished, you screen should look something like this: 
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PUTTING STREAMS ON THE FLOWSHEET 

Streams 

It’s now time to connect the UnitOps with streams. To do this, click the Streams icon box on 

the main palette.  

There are a few general rules to remember when we are drawing streams on the flowsheet:  

1. Each stream goes from a source unit to a destination unit.  
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2. Each unit has inlet and outlet positions. These are established when the symbol is created. 

The program always snaps streams to these positions. During the simulation, a process 

stream always flows from an outlet position on a source unit to an inlet position on a 

destination unit, but when drawing the flowsheet a stream may be drawn in any direction; 

that is; from an inlet position to an outlet position as well as from an outlet position to an 

inlet position.  

3. When starting a stream, the cursor will be a small cross. When the cursor gets near an 

outlet position, it will convert to a black arrow. When this occurs you should left click the 

mouse to start the stream if that is the starting position you desire.  

4. When completing the stream to a unit, the cursor will remain as a black arrow. When the 

cursor is near an inlet or outlet position, a label will appear indicating the location and 

number of the position.  

5. Once the desired position has been located (as indicated by the appearance of the label), 

you should left click the mouse to complete the stream.  

6. While drawing a stream, the palette will disappear. It will reappear only when you left 

click somewhere on the flowsheet which is not a UnitOp inlet or outlet point. You are not 

required to click the stream (link) icon square each time you begin a stream.  

7. You can alternate between placing UnitOps on the screen and connecting them with 

streams as long as the above rules are followed.  

8. The first time you change directions of a stream, CHEMCAD will let you do so without 

any problem. Every additional time you change directions, you must first press the left button 

on the mouse to identify the longitude or latitude through which you want the stream to pass. 

Doing this will create an anchor point to fix the longitude or latitude on the screen.  

9. You may cancel the stream drawing action by double clicking the left button during the 

stream drawing process.  

With these rules in mind, let us now connect the UnitOps with streams.  

Click the Streams icon box on the palette. The palette will disappear and the crosshairs cursor 

will appear. Move the cursor close to the tip of the feed arrow. When the cursor switches to a 

black arrow, press the left button on the mouse. Draw the stream over to the right with your 

mouse. When the label for left-most inlet arrow on the first heat exchanger appears, press the 

left button on the mouse. CHEMCAD will draw the stream directly to that point and will 

place a stream ID number on the flowsheet. CHEMCAD issues ID numbers sequentially, so 

this ID will be Number 1. You may change it using the EDIT STREAM menu (invoked by 

right clicking the stream) if you would like to do so.  

Let’s draw the second stream. Move the cursor to the right-most point of the first heat 

exchanger. When you are close enough to the unit outlet point, the cursor will switch over to 

the black arrow again. Press the left button on the mouse. Draw the stream over to the inlet 

position on the second heat exchanger and, when the label appears, press the left button on 

the mouse again. This should complete Stream 2.  

Next, let’s draw the stream from the second heat exchanger to the flash tank. Locate the right 

most outlet point on the Heat Exchanger unit. When the black arrow appears, click the left 
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mouse button. Now, draw the stream over to the flash tank until the first inlet label appears. 

Press the left button on the mouse to complete Stream 3.  

Let’s draw Stream 4 from the top of the flash tank. Move the cursor near the top of the flash 

tank until the black arrow appears. Press the left button on the mouse. Now, draw the stream 

up about an inch and over to the left until it is directly over the first heat exchanger, then try 

to draw the stream down. You will notice you cannot do it; the entire line moves down with 

you. What we need to do is fix horizontal latitude to which that line is pegged before we 

make our turn. To do this, select your horizontal elevation for your cross-stream and press 

the left button on the mouse. Now, draw the steam down to the top of the heat exchanger. 

When that inlet label appears, press the left button on the mouse. 

Using this procedure, complete the rest of the streams until your flowsheet looks like this: 

 

 

 

If you need to delete or reroute a stream, right click on the stream to call the Edit Stream 

menu. Use the Delete and Re-draw commands as needed.  

When all streams are satisfactorily drawn, double click on a vacant spot on the flowsheet, 

and the palette will reappear.  
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We are now finished drawing our flowsheet. To move on we need to activate the Simulation 

mode. Therefore, at this time click on the Mode command on the menu bar and select the 

Simulation option. The palette will close, and the input functions will become available.  

SELECTING COMPONENTS  

Next let’s identify which components are to be used in this simulation. Selecting the 

ThermoPhysical command does this. Again, this may be done by pressing [ALT + L] or by 

clicking with the mouse. Do this now please. The following menu will open up:  

 

 

 

To choose components from the standard CHEMCAD databank, click the Component List 

option with the mouse. The following Component Selection dialog box will appear. This 

dialog box is organized as indicated below: 
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"Selected Components" area: The current list of selected components will be displayed in 

this area.  

"Component Databank" area: All components stored in the databank(s) are listed here. 

Components are listed in order of their ID numbers. When this area is active, a blue highlight 

will identify one of the components.  

Selection string field: This field is used to locate a component in the databank. Once the 

desired component has been located, it is added to the flowsheet component list by double 

clicking on it or by highlighting it and then clicking on the Add button. The program locates 

components by matching the string entered in this field. The string can be any alphanumeric 

combination. The string will be matched to any part of an ID numbers, formula, or synonym 

(component name) listed in the databank.  

As you type in the string, the program automatically finds and highlights the closest match. 

As the string changes, the highlighted component changes.  

Next button: If the current match is not the component you are looking for, click the Next 

button to find the next matching string.  

Add button: Clicking on the Add button will add the currently highlighted component to the 

end of the flowsheet component list. Components may also be selected by double clicking on 

them. The selected component will appear in the list displayed in the Selected Components 

Area.  

Insert button: This button is used to insert a component somewhere in the component list, 

rather than appending to the end of the list.  

Clear button: The Clear button is used to delete the entire component list. When this button 

is clicked, all of the components listed in the Selected Component Area will be erased.  

Delete button: The Delete button is used to delete individual components from the 

component list. To use this option, highlight the component in the Selected Components Area 

and click the Delete button.  

Copy Components from another job: The Copy Components button is used to import the 

component list from another CHEMCAD job. When this button is clicked, the user is 

prompted to browse for the location of the CHEMCAD job from which the components will 

be imported. These components are then added to the Selected Components Area.  

To show how a component is selected, let’s select Nitrogen. First, click on the Selection 

String Field, and then type in the string "Nitrogen". As you build the string, the program will 

locate and highlight the component nitrogen. To add it to the component list, double click on 

it Or click on the Add button. The component will appear in the Selected Components Area.  

Nitrogen could just as easily been located by entering the string "N2" in the field. The same 

thing could have been done with the string "46" which is the ID number for nitrogen. Strings, 

which comprise only part of the word, number, or formula, can also be used. It is also 

possible to highlight the desired component by clicking on it directly and then clicking the 

Add button.  
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Now select the remaining components in the component list. Remember, if the first search 

does not locate the desired component, click the Next button to find the next matching string. 

Now find the following components and add them to the component list:  

2 Methane  

3 Ethane  

4 Propane  

5 I-butane  

6 N-butane  

7 I-pentane  

8 N-pentane  

10 N-hexane  

The dialog box should now look like this: 

 

 

 

 

 

 

 

 

 

 

Let’s now save our list by clicking the [OK] button. 

SELECTING THERMODYNAMIC OPTIONS  

After the user first selects components the ThermoWizard will appear. The ThermoWizard is 

a system available in the CHEMCAD Suite to assist the user in making K-value and enthalpy 

choices. 

The system works like this:  

1. First, it looks at the component list and decides what general type of model is required, 

i.e., equation-of-state, activity model, etc.  
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2. Next, it looks at the temperature and pressure ranges input by the user and decides which 

equation within a given category is best at the limits of those ranges.  

 

3. If the method is an activity model, the program then looks at the BIP database to see which 

model has the most data sets for the current problem. It then calculates the fractional 

completeness of the BIP matrix. If that fraction is greater than the BIP threshold parameter, it 

uses the chosen activity method; if not, it uses UNIFAC.  

 The K-Value Wizard is no replacement for engineering judgment. The Wizard uses an 

algorithm based on general rules and might not always be correct. The suggested model 

might not be the ‘best’ model for the system.  

Selecting thermodynamic options basically means selecting a model or method for 

calculating vapor-liquid (or vapor-liquid-liquid) phase equilibrium (called the K-value 

option) and selecting a method or model for calculating the heat balance (called the enthalpy 

option). You do this using the ThermoPhysical command located on the menu bar. This is the 

same command you used to access the Component List above. Please click this option now. 

The ThermoPhysical menu should appear as before.  

CHEMCAD has a library of about 50 K-value models with a variety of options, and about 

twelve enthalpy models. Making the proper selection from these libraries can sometimes be 

difficult. The issues involved and the proper techniques for selection are described in the 

Thermodynamics section of the on-line manual. In addition, CHEMCAD has a system 

available to assist the user in making this choice. This feature, called the Thermo Wizard, is 

also described in the Thermodynamics section of the on-line manual. Because the issues 

involved in making thermodynamic selections and in using the Thermo Wizard are beyond 

the scope of this tutorial, let’s assume we know that we want to use the Peng-Robinson 

method for both the K-value and enthalpy calculations. In this case, we would proceed as 

given below.  

  First, we need to accept the default temperature/pressure values for the ThermoWizard,. The 

Wizard will recommend using SRK, please accept this message box. Then let us now make 

our own selection in the K-value Options dialog box. In the upper-left corner of this screen 

will be a combo box labeled Global K-value Option, which is currently highlighted. Please 

open this window by clicking on it.  

First, we need to select our K-value models by pointing and clicking on the K-values option 

on the menu displayed. Please do this now. The K-value Options dialog box will be 

displayed. In the upper-left corner of this screen will be a combo box labeled Global K-value 

Option, which is currently highlighted. Please open this window by clicking on it. Your 

screen should look like this: 
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You will notice the presence of a Scroll Bar at the right of this list indicating that all of the 

available options could not fit into this area. Therefore, the user may scroll through them 

using any of the methods previously described in this tutorial. We would like to use the 

Peng-Robinson method. To make this choice, please scroll up through list; point the arrow to 

the Peng-Robinson option; and click the left button on the mouse. The box will close and 

Peng-Robinson will now be displayed in the field. 

let’s save our selection by pointing and clicking the [OK] button in the upper-left corner. 

This will return you to the Simulation Menu Bar.  

Now, let’s select our enthalpy model. Do this by again clicking the ThermoPhysical 

command, then clicking the Enthalpy option. The Enthalpy Options dialog box will be 

displayed. You will notice on this screen that the Peng-Robinson method has already been 

chosen. The program automatically makes this the enthalpy model when you have chosen the 

Peng-Robinson K-value method. If this assumption is erroneous, you may override it at this 

time. In our case, we would like to use the Peng-Robinson model, so let’s point and click on 

the [OK] button in the upper-right portion of the screen. This will close the Enthalpy Options 

dialog box, saving the currently displayed options. 

For the purpose of our tutorial, the thermodynamic selections are now complete. 
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DEFINING THE FEED STREAMS  
We are now in a position to define the feed streams. This can be done by using the 

Specifications command on the menu bar or by double clicking directly on the stream we 

wish to specify. Double click stream 1. The Edit Streams dialog box will appear like this: 

 

Please note the following points about this dialog box.  

The first field, called Stream Name allows you to enter a stream label or name. This name 

may be up to 16 alphanumeric characters, and will appear on the flowsheet when you close 

this dialog box.  

Note: Entering and/or editing such steam labels can also be done a number of other ways.  

The next four fields; temperature, pressure, vapor fraction, and enthalpy are the 

thermodynamic properties of the stream. According to the Gibbs Phase Rule, once the 

composition is given, specifying any two of the four thermodynamic properties of a mixture 

will define the other two. Thus, defining the composition, temperature, and pressure uniquely 

defines the vapor fraction and enthalpy as well (again this is for a mixture only). Alternately, 

defining the composition, pressure, and enthalpy will uniquely define temperature and vapor 

fraction.  

CHEMCAD, however, by convention, does not permit this much freedom. Since enthalpies 

are calculated relative to a datum, the calculation of any given stream enthalpy is an involved 

process that is prone to errors. For this reason, CHEMCAD does not permit you to enter 

stream enthalpy. (There is one exception to this rule; when the total component flowrate of a 

stream is zero, entering an enthalpy in a stream may serve as an alternative way of adding a 

heat duty to a unit.) Therefore, to uniquely define any stream in CHEMCAD, the user must 

define the composition of that stream, and any two of temperature, pressure, and vapor 

fraction. This is for a mixture. For pure component, all three thermodynamic properties are 

sometimes required.  

The fields Total Flow Units and Comp Units work together to provide the user with a variety 

of ways to define stream compositions. If the Comp Units are set to mole, mass, or volume 

fraction (which can be done globally or locally) then the Total Flow Units combo box will 

become available. If Comp Units is set as a flow or amount option, then the total flowrate 
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becomes the sum of the component flow rates and the Total Flow Units combo box will not 

be available for editing.  

If the Comp Units is set to an amount flow unit (as opposed to mole, mass, or volume 

fractions), then as the component flow rate values are entered, they are automatically 

summed and the current sum is displayed in the field labeled Total Flow.  

In the upper right hand corner of the dialog box is the Flash button. Clicking this button at  

anytime will cause the program to perform a flash calculation using the currently specified 

composition and thermodynamic properties. This allows quick flash calculations to be made 

without exiting the dialog box.  

Fractions that do not sum to 1.0 are automatically normalized upon flashing or exiting the 

dialog box.  

Now, let’s enter the data. Let’s start with temperature. Please move to the temperature field 

by clicking on it.  

Once the highlight is on the proper field, type 75 [down arrow]. When you press the [down 

arrow] key, the highlight will move down to the pressure field. Please enter 200 in this field.  

Next, let’s move down to the Nitrogen field. Please move the cursor down until it points to 

the field to the right of Nitrogen, and click the left button on the mouse. Please enter 100.19 

in this field.  

In a similar fashion, please enter the following numbers in their corresponding fields:  

Methane  4505.48  

Ethane  514  

Propane  214  

I-butane  19.2  

N-butane  18.18  

I-pentane  26.4  

N-pentane  14  

N-hexane  14  

Save this stream information by pointing to the [OK] button in the upper-left corner of the 

dialog box. We are now ready to input the equipment parameters.  

INPUTTING EQUIPMENT PARAMETERS  

Specifying the first heat exchanger…  

In a fashion similar to streams, equipment parameters may be input using either the 

Specifications command on the menu bar or by double clicking directly on the UnitOp we 

wish to specify. Again, the latter is easier, therefore, please point and double click on the first 

heat exchanger now. An equipment-specific input dialog box will appear:  
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Data entry screens can be more than one page long. The buttons called Specifications, Misc. 

Settings, and Cost Estimations indicate the pages for this dialog box. You may browse 

through them by clicking on the tab.  

NOW, LET’S FILL IN THE SCREEN 

Pressure drop for both sides of the exchanger is 5 psi. Enter a 5 for both pressure drop fields.  

We need to specify the first stream outlet to be at its dewpoint. We do this by specifying an 

outlet vapor fraction of 1. Therefore, move to the Vapor Fraction stream 2 field either by 

tabbing down to it or by clicking on it. Then enter 1.  

This completes the input for this unit. We now need to save this information and close the 

dialog box. You do this by clicking on the [OK] button.  

Specifying the second heat exchanger…  

We can now select the next unit for data input. Move the cursor to the second heat exchanger 

and double click. The menu for a single-sided heat exchanger will appear. 
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The outlet temperature from this heat exchanger will determine how much of the liquid is 

removed in the flash drum. This, in turn, will determine the cricondotherm dewpoint of the 

product gas. Therefore, this specification is one of the key parameters of our design. As a 

first attempt, let’s estimate an outlet temperature of -5º F. Therefore, please enter 5 in the 

Pressure Drop field and a –5 in the Temperature of Stream 3 field. Point and click on the 

[OK] button to save the data and close the dialog box.  

Specifying the flash drum…  

In our example, the flash drum is a vapor liquid separator and requires no specification. 

Therefore, we do not need to enter any input for this unit.  

Specifying the valve…  

Let’s enter the outlet pressure for the valve. Please move the cursor to the valve and double 

click. The Valve dialog box will appear. Since our outlet pressure for this unit is 125 psia, 

please enter 125 in the Pressure Out field, then point and click on the [OK] button. This 

completes the input for the valve unit.  
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Specifying the stabilizer tower…  

Now double click tower unit. The TOWR Distillation Column dialog box will appear. There 

are five pages to this screen as indicated by the tabs.  

On the first page, we need to enter the top pressure, which is 125 psia; the column pressure 

drop, which is 5 psi; the number of stages, which is 12, and the feed stage location, which is 

stage number 1. Therefore, please complete your screen as shown below:  

 

 

 

The outlet temperature from this heat exchanger will determine how much of the liquid is 

removed in the flash drum. This, in turn, will determine the cricondotherm dewpoint of the 

product gas. Therefore, this specification is one of the key parameters of our design. As a 

first attempt, let’s estimate an outlet temperature of -5º F. Therefore, please enter 5 in the 

Pressure Drop field and a –5 in the Temperature of Stream 3 field. Point and click on the 

[OK] button to save the data and close the dialog box.  
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Specifying the flash drum…  

In our example, the flash drum is a vapor liquid separator and requires no specification. 

Therefore, we do not need to enter any input for this unit.  

Specifying the valve…  

Let’s enter the outlet pressure for the valve. Please move the cursor to the valve and double 

click. The Valve dialog box will appear. Since our outlet pressure for this unit is 125 psia, 

please enter 125 in the Pressure Out field, then point and click on the [OK] button. This 

completes the input for the valve unit.  

Specifying the stabilizer tower…  

Now double click tower unit. The TOWR Distillation Column dialog box will appear. There 

are five pages to this screen as indicated by the tabs.  

On the first page, we need to enter the top pressure, which is 125 psia; the column pressure 

drop, which is 5 psi; the number of stages, which is 12, and the feed stage location, which is 

stage number 1. Therefore, please complete your screen as shown below:  

 

Let’s continue our data input on the next page. Please click on the Specifications tab. We 

make our specifications for the column on this screen. We have no condenser or side streams 

on this column so we will only be making specifications for the reboiler.  

First, we need to specify our reboiler mode. In order to determine what our options are, 

please point the arrow to the field below the label Select Reboiler Mode and click the left 

button on the mouse. A list should open displaying the available options.  
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As indicated in Figure 1, we need to specify the bottom flowrate for this unit which is Mode 

No. 4. Therefore, please point the cursor to 4 Bottom mole flowrate and click the left button 

on the mouse. The list will close and the field should now read 4 Bottom mole flowrate.  

Now we need to specify the numeric value of that flowrate. This is done in the field 

immediately to the right, which opens after we make our mode selection. Please point the 

arrow to that field, and click the left button on the mouse. This field should be highlighted 

and we can enter a value of 30.  

Now, let’s move to the last page of this data entry screen by clicking the Convergence tab. 

As you can see from the screen, all of the entries on this page are optional. However, for the 

purpose of demonstration, let’s enter an estimate of 50º F for the top temperature and 150º F 

for the bottom temperature. Please point and click on the T top field and enter a value of 50 

in this field. Now move to the field labeled T bottom immediately below. Please enter a value 

of 150 in this field.  

Now we have completed the data input for the tower unit. Let’s save this data by pointing 

and clicking on the [OK] button. When you do this, you will get a warning message saying 

you have not entered an estimate for the distillation rate. In a dialog box, the program will 

ask you if you want to ignore this warning. Warning messages are for your information and 

can normally be ignored; therefore, please click [YES] now. This will return you to the 

Simulation Window. All of the data entry for the flowsheet is now complete.  

RUNNING THE SIMULATION  

To run the simulation, point and click on the RUN command on the menu bar. This will 

cause the RUN Menu to open up like this: 

 

 

 

We want to run a steady state analysis, so select the Run All option.  

The program will first recheck the data and list any errors and/or warnings on the screen. In 

this case, we should have no errors, although we will have warnings saying we have not 

given certain estimates. We can ignore these warnings and proceed by clicking the [YES] 

button. The calculation will then proceed.  

Upon finishing, the CC5 Message Box will appear with the message "Recycle calculation has 

converged". To close this dialog box and clear the screen, you must click on the [OK] button. 
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REVIEWING THE RESULTS INTERACTIVELY  

Now that the simulation is complete, we will want to review the results before printing a 

hardcopy. We do this using the Results and Plot commands on the menu bar. With these 

commands, let’s check whether we have met our design criteria.  

Checking the cricondentherm dewpoint…  

If we have chosen the proper outlet temperature for heat exchanger number 2, the 

cricondentherm dewpoint for the product gas stream (Stream 5) will be 20º F or less. The 

cricondentherm dewpoint, you will remember, is the highest dewpoint temperature a mixture 

will ever see at any pressure. The simplest way for us to identify the highest dewpoint 

temperature of the product gas is to plot all of the dewpoint temperatures of the product gas, 

i.e., to plot a phase envelope. Let’s do that now.  

To plot anything inside CHEMCAD, we must start with the Plot command on the menu bar. 

Please select this option by clicking on it. When you do this, the PLOT MENU will appear. 

On this menu, you will see a list of the general categories of plots available within 

CHEMCAD. Please select Envelopes by clicking on it or by pressing the [E] key.  

The Select streams dialog box will appear. Move the cursor to stream 5 (the product gas 

stream leaving the bottom of heat exchanger number 1) and click it once. The number 5 will 

appear in the dialog box field. Now click [OK] to close the streams selection process. The 

Phase Envelope Options dialog box will appear.  

 

 

No entries on this screen are required since we only need to look at the dew point line. 

However, to make the plot more interesting, let’s display the 0.25 and the 0.5 vapor fraction 

lines in addition to the normal phase envelope boundaries. Therefore, complete the dialog 

box as shown: 
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Now click the [OK] button to save these entries.  

CHEMCAD will perform the required flash calculations necessary to generate the phase 

envelope as specified above. Phase envelope results are produced in two formats:  

1. A numerical tabulation (table) of the temperature, pressure, vapor fraction, vapor 

compressibility factor, and the liquid compressibility factor.  

2. A plot of temperature and pressure for each vapor fraction line requested.  

 

The former is displayed in a Notepad Window; the latter in a Plot Window. Since data for 

these windows is generated simultaneously, both windows are opened. Therefore, when the 

calculations are complete, CHEMCAD quickly displays the Plot Window, then it displays the 

Notepad Window.  

Since we are not going to use the tabulated results, please close the Notepad Window now. 

Your screen will then look like this: 
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You are now in a plot window, and your available commands have changed. Actually, this 

window can be thought of as a plot edit window because it is the same for every plot. It has 

the following commands: 

 

 

 

File 

 

 

This command is for file 

management and print 

control as it is in every 

CHEMCAD window.  

Edit  Contains the undo, cut, 

copyand paste commands.  
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View  Controls the Toolbar and 

Status Bar display status.  

Graph  Provides access to zoom, 

editing and data transfer 

facilities.  

Window  For arranging windows 

and icons.  

Help  Provides access to the on-

line help facility.  

At this point, let’s make note of a few important items regarding CHEMCAD plots.  

1. To zoom in on a certain section of the plot, point to one corner of the area that you want to 

zoom in on, then click-and-drag (i.e., hold down the left mouse button while you are moving 

the cursor) to the opposite corner of that area. When you release the mouse button, the 

program will zoom in on the boxed in area. To restore the original sized, click on the Graph 

command (on the menu bar); then click on the Zoom Out command.  

2. The plot title text (in this case, Phase Envelope for Stream 5) can be edited using the Chart 

Explorer facility within CHEMCAD. This is accessed by clicking on the Graph command, 

then selecting the Edit option.  

3. The color, size, layout and various other aspects of the plot presentation can also be edited 

using the Chart Explorer function.  

4. A hardcopy of this plot can be obtained by clicking the Print button.  

 

Let’s use some of these features to see how they work. First, remembering that we are trying 

to determine if the cricondentherm dewpoint of Stream 5 is 20º F or less, let’s zoom in on the 

graph around the right most area of the curve. 

a. Point the cursor to a point around the 1000 psia, 0 F coordinate on the graph.  

b. Now, push down the left button of the mouse and hold it down while you drag the cursor    

     to the approximate location of the 400 psia, 30 F coordinate.  

c. Release the left button. The program will zoom in on the selected area, and you screen  

      should   look something like this:  
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From this, we can see the highest dewpoint of this mixture is a little less that 20º F. 

Therefore, the cricondentherm dewpoint of this mixture is indeed at or less than our product 

gas specification.  

Our plot is now finished. To print the display, click the Print button.  

This finishes our plot exercise. Please return to the main window by closing the current 

window. Therefore, please click the ⌧ button on the right hand side of the second bar. This 

will return you to the main CHEMCAD window.  

Checking the bottoms stream purity…  

Our second specification requires that the percent of propane in Stream 9 is to be 1%. We can 

check and see if we have achieved this specification by using the Results command. Please 

point and click on the Results command or press [ALT + U] now. When you do this, the 

Results menu will appear.  

We want to check stream compositions, and we want to do it in mole percent. Therefore, we 

must first set our flow units. Please point and click on the Set Flow Units option now. The 

View Flow Rate Unit dialog box will appear. Please point and click on the option, which says 

Mole %. Then click [OK]. You will be returned to the Main CHEMCAD Window.  

Now click Results again. On the Results Menu, highlight Stream Compositions. On the 

STREAM COMPOSITIONS MENU, which appears, click on Select Streams. The Select 

Streams dialog box will appear. As before, use  the mouse to point to stream 9 and click 

once. Now click [OK]. The following display will appear:  
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If the default Flowsheet Quickview option of the View menu is check-marked, you may also 

place the cursor on stream 9 and a summary for the stream will be displayed. We can see 

from this display that propane is far below our 1% specification. This means our design is too 

conservative. To correct this, let’s go back and re-specify the column to produce precisely 

1% propane in the bottom.  

Please click the close button once. 

RE-RUNNING THE SIMULATION  

Let’s re-run the stabilizer specifying that we want 1% propane in the bottom. To do this, 

please double click on the Tower UnitOp.  

The TOWR Distillation Column data entry dialog box for the stabilizer should reappear.  

Now, let’s click on the Specifications page of the dialog box. We want to change our 

specification from Bottom mole flowrate to a purity specification. Therefore, we must start 

by changing the mode of the specification. To do this, please point and click on the field 

below the Select reboiler mode option and select Mode 6. This field should now read 6 

Bottom component mole fraction. To complete our specifications, we must identify what 

that purity is and for which component it is being specified. In the Specification field to the 

right, we want to enter .01 instead of the present 30. Please do this now. Next, we must 

identify the component for which we are making a purity specification. To do this, click on 

the component field. A list of all of the components in the component list will open. Click 

on propane. The list will close.  
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Please click on the third page of the screen. Since we have run this condensate stabilizer 

before, we want to instruct the program to pick up where it left off at the end of the last 

simulation. We do this by making the proper selection in the field labeled Initial flag under 

Convergence parameters. Please click on this option. A list will open displaying the available 

options. The option we want is option number one, Reload column profile.  

We have now made all the changes required to rerun the condensate stabilizer. Let’s save 

them by pointing and clicking on the [OK] button.  

Please point and click on the Run option on the menu bar. This will cause the Run Menu to 

reappear. Please note at this point that since the only unit affected by our changes is the 

condensate stabilizer itself, it is not necessary to rerun the entire flowsheet. Therefore, let’s 

only rerun Unit 5, the condensate stabilizer. We do this by pointing and clicking on the Run 

selected Units option. Please do this now.  

When we opened the Tower dialog box, we "selected" the Tower UnitOp (UnitOp No. 5). 

When we closed that dialog box, UnitOp No. 5 remained selected even though its dialog box 

was closed. Therefore, when we told the program to "Run selected units", it immediately ran 

UnitOp No. 5 because it was "selected". Selected objects are indicated by the four corner 

boxes which surround them.  

When the calculation is finished, the message "Calc Unit 5 TOWR" will appear to the left on 

the bottom line of the CHEMCAD window. This should happen almost immediately since 

the stabilizer runs very fast.  

We now want to insure that we have 1% propane in the bottom stream. We will again do this 

with the Results command. Please point and click on the Results command on the menu bar. 

This will cause the Results Menu to appear.  

Now, highlight the Stream Compositions option and display Stream 9 using the following 

steps:  

1. Point and click on the Select Streams option.  

2. Move the cursor to Stream 9, then press the left mouse button.  

3. Click [OK].  

 

Stream 9 should now be displayed in a Notepad Window. We can see that propane is now 

1%, as desired.  

Now click the Notepad close box to close the stream composition display. 

PRODUCING A REPORT  

To produce a hardcopy output of any kind, use the Output option on the menu bar. Click 

Output or press [ALT + O]. The OUTPUT MENU will appear, and you will have the 

following options:  

Job Note For including and storing comments on the simulation job.  

Report For generating tabular hardcopy outputs.  

Main PFD For producing and editing the primary (first) process flow diagram.  
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New PFD For  producing additional process flow diagrams.  

Open PFD For editing process flow diagrams other than the main PFD.  

Let’s choose the Report option by pressing the [R] key. This will cause the Report Menu to 

appear. 

 

For the purpose of this demonstration, let’s assume we want to print out the following 

information:  

1. For Streams 1, 5, 8 and 9, let’s print the stream composition in mass flowrates and mole 

fractions, as well as the default stream properties.  

2. The equipment summaries for every piece of equipment in the flowsheet.  

3. Tower profiles for the condensate stabilizer.  

 

We will begin with Item 1 above. We must first specify which streams we want to print out. 

To do this, use the Select Streams option on the Report Menu. Please point and click on this 

option now. The Select Streams dialog box will appear and will permit you to identify the 

desired streams either with the use of the mouse, or by entering the stream ID numbers in the 

boxes provided. Using the mouse employs the same stream selection procedure illustrated 

above, therefore, let’s type in the desired stream numbers this time. To do this, follow the 

procedure given below:  

1. Select "No" in the small box next to the label Print ALL streams?  

2. Select "Yes" in the field labeled Select from flowsheet graphic?  

3. Now we need to identify streams 1,5,8,and 9 as the selected streams. First, click on the 

stream ID box in the upper left-hand corner under the label Enter the stream ID’s.  
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4. Type the number 1 into the field.  

5. Now, click on another field and type the number 5. It does not matter which box you 

select. Any box will do, even if it is not contiguous to the first box.  

6. Select boxes for the other streams, and enter the numbers 8 and 9  

7. To close the Select Streams dialog box, click on the [Save] button.  

We should now be back on the Report Menu.  

Our next step will be to select the flow units for the stream compositions print out. To do 

this, we use the Stream Flowrate/Composition option on the Report Menu. Please select this 

option now. Your screen should look like this:  

 

 

 

 

You will notice that in the default condition the stream compositions will be printed out in 

units of molar flowrate. For Tutor1, we do not want mole flowrates; we want mass flowrates 

and mole fractions. Therefore, we first need to turn the Mole flow rate off. You can do this 

by pointing and clicking on the box to the left of the label. This box currently contains a 

checkmark indicating that, at this time, mole flowrates is an active selection. Please point and 

click this box now.  

Now, let’s turn the mass flowrate option on. Please point and click on the Mass flowrate box 

now. Finally, let’s turn the Mole Fractions option on by pointing and clicking on that option. 

Your screen should look like this: 
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Please save these entries by pointing and clicking on [OK] in the bottom-right corner of the 

dialog box. This will return you to the Report Menu.  

Now, let’s select stream properties. Please select the Stream Properties option on the Report 

Menu. The Property Options dialog box will appear. Please note this dialog box has two 

pages. You will also notice this is an on/off selection screen similar to the 

Flowrate/Composition options dialog box. Whichever options have a checkmark in the box 

next to them will be printed. Whichever options do not have a checkmark in the box next to 

them will not be printed. The user may turn these options on/off by pointing and clicking 

with the arrow. For the purpose of this demonstration, we will use the default settings for 

stream properties output. Therefore, please exit this menu by pointing and clicking on 

[CANCEL] in the upper portion of the screen. This will return you to the Report Menu.  

Let’s select which pieces of equipment or unit operations we want to include in our output 

report. To do this, select the Select Unit Operations option on the menu. Please do this now. 

The Select Unit Operations data dialog box will appear. As you can see, this dialog box is 

very similar to the Select Streams dialog box, which we encountered earlier. In the default 

condition, all unit operations are output. If the user chooses to override this default, he/she 

may do so by either entering the unit operations numbers in the column at the bottom of the 

screen using the keyboard or by clicking on the Select from flowsheet graphics option on the 

screen. Then the select cursor will appear and unit operations will be selected in precisely the 

same manner as streams selected earlier. In our case, we are going to print all the unit 

operations. Since this is the default, we will make no changes. Please point and click on 

[OK].  

For our final selection, we are going to specify which information is going to be printed for 

the condensate stabilizer distillation column. To do this, please select the Distillation 

Summaries option on the menu. The Distillation Options dialog box will appear and will 

permit you to do the following things:  

1. Tray profile – Print a tabular summary of the tray profiles for the column, i.e., for each 

stage the program will print the temperature, pressure, vapor flowrate, liquid flowrate, and 

any feeds and products going to or from the stage.  
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2. Tray properties – A tabular summary of the transport properties of the vapor and the liquid 

on each stage of the column.  

3. Tray sizing – Results of tray sizing calculations for each stage of the column. The user 

may select from valve, sieve, or bubble cap trays.  

4. Packed column sizing – Packed column sizing and pressure drop calculation results.  

5. Tray compositions – Tray compositions may be printed in mole or mass flowrates as well 

as mole or mass fractions. Only one may be selected.  

 

We are going to print only the tray profiles described in Item 1 above. As you can see from 

the checkmark on the dialog box, this is the default option. Therefore, please click [OK] to 

return to the Report Menu.  

We are now ready to generate our report. Please point and click on the option which says 

Calculate and Give Results. When you do this, the report will be displayed in a Word 

window. It will be formatted exactly as it would on paper.  

To print this report, click the Print button on the toolbar.  

Once we are finished with the report, close the Word window by clicking the close button. 

The Report Menu will reappear.  

You can now return to the main CHEMCAD window. 

 

GENERATING THE PROCESS FLOW DIAGRAM  

Another way to obtain a hardcopy output is to create a process flow diagram (PFD). Select 

the Main PFD option on the Output Menu. Optionally, the user might either choose the Main 

PFD option from the Change Mode combo box on the tool bar or select the Main PFD option 

from the Mode command.  

The program will go into "PFD mode", which means it will open up certain commands and 

features that up to now have been unavailable. These are:  

Add Stream Box – The Add Stream Box command is used to create stream data boxes. 

Stream data boxes can be used to display the heat and material balance and stream properties. 

As many stream data boxes as desired can be placed on a PFD. This command is located on 

the Format menu.  

Add UnitOp Box - The Add UnitOp Box command is used to create unit operation data 

boxes. Unit operation data boxes can be used to display the input and/or output of UnitOps 

on the flowsheet. As many UnitOp data boxes as desired can be placed on a PFD. This 

command is located on the Format menu.  

Add TP Box - The Add TP Box command is used command is used to display the 

temperature, pressure, and/or flowrate of a stream in small boxes attached to the relevant 

stream. This command is located on the Format menu.  

Add Excel Range - The Add Excel Range command is used to easily display simulation data 

from Excel Data Sheets that your computer has access to. It is updated after a new run is 

made.. This command is located on the Format menu.  
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Refresh Data Boxes – The Refresh Data Boxes command is used to update the stream and 

UnitOp data boxes after a new run has been made. It is located on the View menu.  

The PFD palette – The PFD palette is a small palette which contains only those graphics 

functions which are relevant to creating a PFD. The are the select, rotate, rectangle, ellipse, 

line, multiline, text, and Job box functions. These are described below and in the "Drawing 

with the Palette" and "How to put text on a drawing" sections of this User’s Guide.  

Other commands not consistent with the creation of PFD will "gray out" or become 

unavailable until we switch back into simulation mode.  

The process of creating PFD’s consist of the following activities:  

1. Creating and placing Stream Databoxes on the drawing. Stream databoxes are framed 

tabulations of the heat and material balance and stream properties. The content and style of 

these databoxes is within the user’s control.  

2. Creating and placing Unit Operation Databoxes on the drawing. Unit Operations databoxes 

are framed tabulations of selected input and output values for each unit operation on the 

flowsheet. Again, the style and content of these databoxes is within the user’s control.  

3. Displaying simulation data on the drawing. The user may paste relevant simulation 

information from an Excel data sheet into the drawing. Again, the style but not the content 

(unless modified from the Excel file) of these databoxes is within the user’s control.  

4. Adding text to the drawing. Using the text facility of CHEMCAD, Titles, notes, and 

various other text can be placed on the PFD.  

5. Placing symbols in the PFD. The user can create and store symbols, such as company 

logos, in a symbols library for later retrieval and placement on CHEMCAD drawings.  

6. Drawing primitive (i.e., simple) objects. A variety of 2D objects are available to the user 

for freehand object creation.  

 

To see how these work, let’s draw the PFD.  

In order to have adequate space to place additional information on the PFD, the first thing we 

need to do is reduce the size of the flowsheet. Please click on the Zoom Out option located 

on the tool bar.  

 

 

The flowsheet will shrink in the middle of the screen.  

Creating a stream databox…  

Now, let’s place the heat and material balance for the flowsheet on the screen. This information 

is contained in a Stream Databox. A stream databox is created using the following process.  

1. Click the Format command on the menu bar. The Format Box Menu will appear.  
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2. Click the Add Stream Box option on the Format Menu. The Select Streams dialog box will 

appear.  

 

 

 

 

 

 

Normally this dialog box would be used to list the streams which are to be included in the 

streams databox. In our case however we will include all the streams in the databox, so we 

don’t have to list the streams. The default is to include all streams. Therefore, click the [OK] 

button to close the dialog box.  

 

The PFD Property Options dialog box will open.  

3. The PFD Property Options dialog box looks like this:  
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This dialog box is used to select which items (for each stream) are to be included in the 

databox. 

Items are selected by clicking the small box next to them. A checkmark indicates that the 

item will be included. An empty box indicates that the box will not be included in the 

databox.  

For the purposes of this demonstration, let’s accept the default settings. Therefore, please 

click the [OK] button to close this dialog box and save its’ current settings.  

 

4. You will now see the Data Box Settings dialog box . This dialog box looks like this; 
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Obviously this dialog box is used to make format settings for the databox. For simplicity 

accept the default settings by pressing the [OK] button now. The stream databox will appear 

in the upper left-hand corner of the PFD.  

6. Now let’s move the databox so that it fits along the bottom of our PFD. To do this, move 

the cursor until it is over the databox. Then, while holding down the left button, move the 

mouse around until the databox is in the bottom center of the PFD like so: 

 

 

7. Now let’s resize the databox. Point the cursor to one of the small, black squares at the 

corners or the databox. Then, while holding down the left mouse button, roll the mouse 

around. As you do so the databox will change size. Move the mouse until the databox is the 

correct size, then release the mouse. 
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Our stream databox has been successfully completed. You can put as many stream databoxes 

on a PFD as you desire. Thus one databox might contain the heat and material balance, while 

another contains the stream transport properties. Alternately, one databox might contain 

stream one through twenty, while another contains streams thirty through fifty. The system is 

extremely flexible.  

UnitOp databoxes can be created using the same process outlined above. These databoxes 

can contain input and/or output information for any selected UnitOp on the flowsheet. 

Placing text on the PFD…  

 

 

 

Text and other symbols and objects can be put on the PFD also using the PFD palette. To call 

the PFD palette, click on the Data Box command on the menu bar, then select the Palette 

command at the bottom of the Data Box Menu. A small PFD Palette will appear at the 

bottom left of the window.  

Text can be created and placed on the PFD using the "ab" square at the far right of the 

palette. Please click on this square now. The palette will disappear and the text cursor will 

appear. Locate the cursor towards the top left of the PFD in a position appropriate for a title, 

then press the left mouse button. Now type the PFD title, "Condensate Stabilizer PFD". 

When finished double click on some vacant spot. The palette will reappear.  

We now have a complete process flow diagram. We can generate a hardcopy of this PFD by 

clicking the Print button. To close CHEMCAD, click on the Close in the upper right hand 

corner of the window. When you do this CHEMCAD might ask you if you want to exit 

CHEMCAD. Please answer "yes".  

We are now finished with our demonstration. 

 

SUMMARY  

During this tutorial we have accomplished the following things:  

1. Set up a new problem.  

2. Drawn our flowsheet.  

3. Interactively prepared our input.  

4. Run the simulation.  

5. Interactively changed our input.  

6. Rerun the simulation.  

7. Plotted and viewed the results interactively.  

8. Produced a tabulated report of results.  

9. Produced a process flow diagram.  

 

These are the major functions within the process simulation portion of CHEMCAD. 
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CHEMCAD Tutorials 

 

Although the simulations stored in your Examples directory are useful for many scenarios, 

the best way to learn to use CHEMCAD is to create and run simulations yourself. The 

tutorials in this chapter walk you through basic simulation building step by step, using a 

realistic example problem that will help prepare you for your own simulations. 

The first tutorial is for a simple steady-state simulation, which is then used as the basis for 

the second tutorial, in which you’ll learn to use the CC-THERM module to rate a heat 

exchanger.  

 
CC-STEADY STATE Tutorial 
This tutorial creates a basic steady‐state simulation for a condensate stabilizer plant. In this 

plant, gas enters the system with the feed conditions shown in the following diagram: 

 

 

 

 

Your job is to determine new operating conditions for this existing plant, along with any 

necessary modifications. The design requirements are as follows: 

• The cricondentherm dewpoint of the product gas must be 20 °F or less. A cricondentherm 

dewpoint is the highest temperature for two‐phase coexistence of a mixture. As long as the 

stream temperature stays above the cricondentherm dewpoint, the stream contents will not 

condense. 
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• The stabilized condensate must have maximum propane content of 1%. 

 

Overview 
Running a flowsheet simulation in CHEMCAD is essentially a nine‐step procedure: 

1. Start a new simulation. 

2. Select engineering units. 

3. Create a flowsheet. 

4. Select components. 

5. Select thermodynamics options. 

6. Define the feed streams. 

7. Enter UnitOp parameters. 

8. Run the simulation. 

9. Review the results and print as needed. 

 

The steps do not have to be performed in this order, nor do all of them have to be done for 

each flowsheet, but you should consider all steps for each problem. 

 

Starting a New Simulation 
Start by creating a new simulation and giving it a name. 

 

To do this, launch CHEMCAD and then Select File > Save to open the Save As dialog box. 

Navigate to the directory where you want to store the simulation (try My Simulations, 

located under My Documents) and give your simulation a name, leaving the type as 

CHEMCAD 6 (*.cc6). Then click Save to create the file and return to the main CHEMCAD 

window. 

Note: Instead of saving all changes instantly, CHEMCAD now saves your simulation only 

when you use the Save command. This provides you with greater flexibility and gives you 

more control over your simulations, but it also means that you should save your work 

frequently. This is a sound practice for working in any software application, as it can help 

you avoid losing work in the event of a power problem or computer glitch. 

 

Selecting Engineering Units 
Select Format > Engineering Units to open the Engineering Unit Selection dialog box. 

The English units option is the default and is currently highlighted. To change the 

engineering units system, you would click the Alt SI, SI, or Metric button; you could then 

change any of the individual units as well. For this tutorial, you will use English units, so 

click Cancel to exit this dialog box without making changes. 

 

Drawing the Flowsheet 
  Creating a flowsheet is a matter of placing UnitOp icons on the screen, connecting them 

with streams, and then adding various graphical objects to enhance the drawing. 

 

Placing UnitOps 

1. Start your flowsheet by adding an icon to represent the initial feed stream. In the All  

UnitOps palette, find the Feed icon, which is an arrow pointing to theright. Click the  
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Feed icon, then click in the workspace where you want to place the feed stream. 

When the feed stream arrow appears, go ahead and turn off the Feed drawing tool by right‐
clicking any blank area of the workspace. 

 

Note: At any time after drawing a feed stream or any UnitOp icon, you can click the icon to 

display the black sizing handles at each corner. With the icon selected this way, you can click 

the icon and drag it to a new location, or click any sizing handle and drag it outward or 

inward to resize the icon. 

 

2. Now place the two heat exchangers on the flowsheet. On the All UnitOps palette, point to 

the Heat Exchanger icon until its pop‐up label appears (see Figure 1). 

 

 

Figure 1: The pop-up label that identifies the UnitOp icon 

3. Click the lower right corner of the Heat Exchanger icon, on the black triangle,to open the 

sub‐palette. Select the two‐sided heat exchanger icon as shown in Figure 2. The icon 

that you clicked in the sub‐palette now appears on the main All UnitOps palette to represent 

the Heat Exchanger UnitOp. 

 

Figure 2: Selecting the two-sided heat exchanger icon 
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4. Point the mouse cursor about an inch to the right of the feed icon and click. A two‐sided 

heat exchanger icon appears on the flowsheet where you clicked. 

Note: The UnitOp ID label of 1 should appear in a circle next to the heat exchanger icon. For 

each subsequent UnitOp that you draw, CHEMCAD will assign an ordinal number in this 

way, to uniquely identify each piece of equipment on the flowsheet. 

 

5. Return to the All UnitOps palette, and again click the Heat Exchanger icon’s black 

triangle. To switch from the two‐sided model to a single‐sided model, you’ll need to select 

the appropriate icon (see Figure 3) from the Heat Exchanger sub‐palette. 

 

 

Figure 3: Switching to the single-sided heat exchanger icon 

6. Again move the cursor to the workspace, this time about an inch to the right of the first 

heat exchanger, and click the mouse. A single‐sided heat exchanger icon appears on the 

flowsheet where you clicked. Your flowsheet so far should look something like Figure 4. 

 

Figure 4: The flowsheet so far 

7. Add the Flash and Valve UnitOp icons to your flowsheet, using the standard icons. 

 

8. For the condensate stabilizer, use a distillation column. Multiple distillation UnitOps are 

available, but for now, assume that the module you want to use is the rigorous distillation 

model called Tower. You’ll need a Tower icon with trays and a reboiler but no condenser; 

this is different from the default Tower UnitOp icon. Click the lower right corner of the 

Tower icon’s box to view the sub‐palette, then select the icon shown in Figure 5. 
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Figure 5: Selecting the appropriate Tower UnitOp icon 

9. Now that you have selected the appropriate Tower icon, add this UnitOp to the flowsheet. 

 

10. Place three Product icons on the flowsheet, one for each product stream. You can quickly 

place three identical icons, simply by clicking repeatedly in a slightly different location. 

When you’ve clicked to create the third Product icon, right‐click to turn off the Product 

drawing tool. 

 

Drawing Streams 
Now that all of the UnitOps are in place, select the Stream tool and connect the various 

UnitOps as appropriate. Remember that each stream must start at a red outlet point on the 

upstream UnitOp, and end at a blue inlet point on the downstream UnitOp. 

 

To avoid having to re‐select the Stream tool each time, make sure that as soon as you click to 

complete one stream, you move the cursor to the next location and click to start the next 

stream. 

 

Draw streams to connect the following: 

 

• Feed stream to first heat exchanger’s left‐side inlet 

• First heat exchanger’s right‐side outlet to second heat exchanger’s left‐side inlet 

• Second heat exchanger’s right‐side outlet to flash inlet of your choice 

• Flash top outlet to first heat exchanger’s top inlet 

• First heat exchanger’s bottom outlet to nearest product icon 

• Flash bottom outlet to valve inlet 

• Valve outlet to tower inlet of your choice 

• Tower top outlet to nearest product icon 

• Tower bottom reboiler outlet to nearest product icon 

 

As you draw streams, CHEMCAD assigns stream IDs, just as it assigned UnitOp IDs when 

you created those items. The labels for stream IDs are displayed in squares, to distinguish 

them from the UnitOp IDs displayed in circles. 
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Selecting Components 

 

Now you need to identify the components to be used in this simulation. Start by selecting 

Thermophysical > Select Components. This brings up the Select Components dialog box, 

shown in Figure 6. 

 

Figure 6: The Select Components dialog box 

For this example, you’ll choose components from the standard CHEMCAD database. In the 

Select Components dialog box, find and add each needed component, beginning with 

nitrogen: 

1. In the Search box, start typing the word nitrogen. 

 

2. As soon as you’ve typed ni, you should see 46 – Nitrogen – N2 highlighted in the 

Available Components area. Click the right arrow button to add nitrogen to your simulation. 

 

3. Use the scroll bar in the Available Components area to return to the top of the component 

list. 

 

4. Hold down the [CTRL] key on your keyboard as you click each of the following 

components in turn: 

• 2 Methane 

• 3 Ethane 

• 4 Propane 

• 5 I‐Butane 

• 6 N‐Butane 
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5. Click the right arrow button, located to the right of the Available Components area, to add 

all of the selected components to your simulation. 

6. Now add the following components by double‐clicking each one in turn: 

• 7 I‐Pentane 

• 8 N‐Pentane 

• 10 N‐Hexane 

 

Figure 7: The completed Select Components dialog box 

7. Save your component selections by clicking OK. 

 
Selecting Thermodynamic Options 
 

As soon as you have finished component selection, the Thermodynamics Wizard appears. 

This tool can suggest thermodynamics options to use with this simulation. 

CHEMCAD’s Thermodynamics Wizard works like this: 

1. First, it looks at the component list and decides what general type of model is required, 

i.e., equation‐of‐state, activity model, etc. 

 

2. Second, it looks at temperature and pressure ranges that you provide and decides which 

equation within a given category is best at the limits of those ranges. 

 

3. If the method is an activity model, the program then looks at the BIP database to see which 

model has the most data sets for the current problem. It then calculates the fractional 

completeness of the BIP matrix. If that fraction is greater than the BIP threshold parameter, it 

uses the chosen activity method; if not, it uses UNIFAC. 
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The Thermodynamics Wizard is no replacement for engineering judgment. This tool uses 

an algorithm based on general rules, and is therefore fallible. The suggested model might not 

always be the best model for the system. 

Selecting thermodynamic options basically means selecting a model or method for 

calculating vapor‐liquid (or vapor‐liquid‐liquid) phase equilibrium (called the Kvalue model) 

and selecting a method or model for calculating the heat balance (called the enthalpy model). 

The commands for these selections are located on the Thermophysical menu. 

CHEMCAD has a library of dozens of K‐value models with a variety of options and about 12 

enthalpy models. Making the proper selection from these libraries can sometimes be difficult. 

For the purposes of this tutorial, assume that you want to use the Peng‐Robinson method for 

both the K‐value and enthalpy calculations. Follow these steps to select your thermophysical 

options: 

1. Accept the default temperature and pressure ranges in the Thermodynamics 

Wizard and click OK. 

2. Click OK again to accept the wizard’s suggested method of SRK. 

3. When the Thermodynamic Settings dialog box opens, find the Global KValue Model 

selection, in the upper left corner of the K‐Value Models tab. The current setting is SRK, but 

for the purposes of the tutorial, you’ll need to select the Peng‐Robinson model. Click the 

down arrow at the right end of the selection box to view a long list of K‐value choices, then 

click Peng‐Robinson. 

 

Figure 8: The new K-value selection in the Thermodynamic Settings dialog box 
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4. Now click the Enthalpy Models tab. The Peng‐Robinson method has already been entered 

as the Global Enthalpy Model selection; this was done automatically because you chose 

Peng‐Robinson as your K‐value method. While you do have the option to override this 

choice, in this case you’ll need to keep the Peng‐Robinson model; leave all settings as they 

are and click OK to return to the main CHEMCAD workspace. 

For the purpose of this tutorial, the thermodynamic selections are now complete. 

Note: While you are not required to use the Thermodynamics Wizard, you should 

know how to use it, if only as a starting point for your simulations. You can revisit 

the wizard at any time by selecting Thermophysical > Thermodynamics Wizard. 

Defining the Feed Streams 
Now it’s time to define your simulation’s feed stream. There are several ways that 

you can do this, but the quickest and most efficient way to define a single stream is 

to double‐click the stream line. 

Note: Before you proceed, verify that your engineering units are set to English in the 

Engineering Unit Selection dialog box, as described earlier in this tutorial.  

Double‐click the line for stream 1, your feed stream, to bring up the Edit Streams dialog box. 

 

 
Figure 9: The Edit Streams dialog box 
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You will specify the feed stream according to the following rules: 

 

• The Stream Name field can display a stream label of up to 16 alphanumeric characters. 

This field is optional, and you can use any label you like. 

 

• The next four fields—Temp F, Pres psia, Vapor Fraction, and Enthalpy MMBtu/h—are 

the thermodynamic properties of the stream. According to the Gibbs Phase Rule, once a 

mixture’s composition is given, specifying any two of these four thermodynamic properties 

will define the other two. As such, defining the composition, temperature, and pressure for a 

mixture uniquely defines its vapor fraction and enthalpy. Alternatively, defining the 

composition, pressure, and enthalpy will uniquely define the mixture’s temperature and 

vapor fraction. 

 

Since enthalpies are calculated relative to a datum, the calculation of any given stream 

enthalpy is an involved process which is prone to errors. For this reason, CHEMCAD does 

not permit you to enter stream enthalpy as a constraint. 

 

In addition to defining the stream’s composition, you must define exactly two of the 

following properties: temperature, pressure, and vapor fraction. The two variables that you 

specify will display as red text, while the third variable and the value enthalpy will be 

displayed in black when you flash the stream. 

 

An exception to this convention allows you to add heat duty with an empty stream. If you 

specify a total component flow rate of zero, you may specify a temperature, pressure, and 

enthalpy rate. A stream defined this way is treated as a heat duty, and is added to the heat 

balance of the unit. The temperature and pressure are arbitrary for this situation. 

 

• The Total flow unit and Comp unit fields work together to provide a variety of ways to 

define stream compositions. If the selected comp unit is mole, mass, or volume fraction 

(either globally or locally), then the Total flow unit selection is available. If the selected 

comp unit is a flow or amount option, then the total flow rate becomes the sum of the 

component flow rates, and the Total flow unit selection is not available. 

 

• If the Comp unit field selection is an amount flow unit (as opposed to a fractional unit), 

then the component flow rate values are automatically added as you enter them. The current 

sum is displayed in the Total flow field. 

 

• You can click the Flash button at any time to perform a flash calculation using the currently 

specified composition and thermodynamic properties. This enables you to obtain flash 

calculations quickly and without leaving the dialog box. 

 

• Fractions that do not add up to 1.0 are automatically normalized when you either click   

  Flash or exit the dialog box. 

 

With these rules and behaviors in mind, enter the data for your feed stream. 
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1. Begin with the stream temperature. Click the Temp F label, then click the empty field to 

its right. Type 75 and then press the down arrow key on your keyboard to continue. 

 

2. Type 200 in the Pres psia field, then press the down arrow key several times until you 

arrive at the Nitrogen field. 

 

Note: Before you continue, verify that the Comp unit field is set to lbmol/h. 

 

3. Type 100.19 in the Nitrogen field, and then in similar fashion, type the following numbers 

in the corresponding fields: 

 

• Methane: 4505.48 

• Ethane: 514 

• Propane: 214 

• I‐Butane: 19.2 

• N‐Butane: 18.18 

• I‐Pentane: 26.4 

• N‐Pentane: 14 

• N‐Hexane: 14 

 

4. Click OK to save this stream information and return to the main CHEMCAD workspace. 

Enter UnitOp Parameters 

 

Now that you’ve specified your feed stream properties, it’s time to specify the characteristics 

of your UnitOps. The following sections address each UnitOp in turn. 

 

Note: As with streams, you can enter UnitOp parameters in various ways, but for the 

purposes of this tutorial, we’ll use the quickest and simplest method, double‐clicking 

each UnitOp to access its specification dialog box. 

 

First Heat Exchanger 

1. Double‐click the flowsheet icon for the first heat exchanger. The Heat 

Exchanger dialog box will appear, as shown in Figure 10. 
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Figure10: The Heat Exchanger dialog box 

 

2. As with many types of UnitOps, the dialog box for specifying a heatexchanger consists of 

multiple tabbed pages. You can browse through theSpecifications, Misc. Settings, and Cost 

Estimations tabs by clicking eachtab in turn. 

 

3. The pressure drop on both sides of this exchanger is 5 psi. On the Specifications tab, find 

the Pressure Drops area, and enter 5 in both the Stream 1 and Stream 4 fields. 

 

4. The first stream outlet must be at its dewpoint, so you’ll need to specify an outlet vapor 

pressure of 1. In the field next to Vapor fraction stream 2, enter 1. 

 

5. Click OK to save the specifications for this UnitOp and close the dialog box. Second  

 

Heat Exchanger 

1. Double‐click the flowsheet icon for the second heat exchanger. The Simple Heat 

Exchanger dialog box will appear. 

 

2. The outlet temperature from this heat exchanger will determine how much of the liquid is 

removed in the flash drum. This, in turn, will determine the cricondentherm dewpoint of the 

product gas. Therefore, this specification is one of the key parameters of this process. As a 

first attempt, use an outlet temperature of ‐5 °F. Enter 5 in the Pressure drop field and –5 in 

the Temperature of stream 3 field. 
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Figure 11: Setting up the second heat exchanger 

 

Flash Drum 

In this simulation, the flash drum is a vapor‐liquid separator and requires no specification. 

 

Valve 

1. Double‐click the valve flowsheet icon to bring up the Valve dialog box. 

2. The outlet pressure for this unit is 125 psia, so enter 125 in the Outlet pressure field. 

3. Click OK to save the specifications for this UnitOp and close the dialog box. Stabilizer  

 

Tower 

1. Double‐click the tower icon to open the TOWR Distillation Column dialog box. Note that 

the settings for this UnitOp are divided into five tabs. 

2. On the General tab, enter the following: 

• Colm press drop: 5 

• No. of stages: 12 

• Feed tray for stream: 1 
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3. Click the Specifications tab to make specifications for the column. This column has no 

condenser or side streams, so you will only be making specifications for the reboiler. Drop 

down the list of options for Select reboiler mode, and select the mode called 4 Bottom mole 

flowrate. 

4. Now you need to specify the numeric value of the reboiler flow rate. In the Specification 

field immediately to the right of your reboiler mode selection, enter a value of 30. 

 

5. Click OK to save the specifications for this UnitOp and return to the main CHEMCAD 

workspace. 

 

All of the data entry for the flowsheet is now complete. Before you continue, you should save 

your simulation. As noted earlier, it’s a good idea to do this periodically as you build the 

simulation, but completion of your UnitOp specifications is a particularly good time to stop 

and save. 

 

Run the Simulation 

To run the simulation, click the Run All button on the toolbar. 

The program first rechecks the data and lists any errors and warnings in the Messages pane. 

In this case, you should have no errors, although you will have warnings about estimates you 

have not given. You can ignore these warnings and proceed by clicking Yes. The calculation 

will then proceed. When the run finishes, a message box appears: Recycle calculation has 

converged. To close this dialog box and clear the screen, click OK. 

 

Review the Results and Print as Needed 

Before running and printing reports and plots, you should review the simulation to verify 

whether it meets the design criteria set out for this problem. 

 

Checking the Cricondentherm Dewpoint 

If you have chosen the proper outlet temperature for the second heat exchanger, the 

cricondentherm dewpoint for the product gas stream (stream 5) will be 20 °F or less. The 

cricondentherm dewpoint, you will recall, is the highest dewpoint temperature a mixture will 

ever see at any pressure. The simplest way to identify the highest dewpoint temperature of 

the product gas is to plot all of the dewpoint temperatures of the product gas, i.e., to plot a 

phase envelope. 

 

1. Start with the Plot menu, which provides access to all types of graphical reports. Select 

Plot > Phase Envelopes. In the Select Streams dialog box, specify stream 5, then click OK 

to bring up the Phase Envelope dialog box. 

 

2. No entries are required on this screen since you only need to look at the dewpoint line, but 

to make the plot more interesting, display the 0.25 and the 0.5 vapor fraction lines in addition 

to the normal phase envelope boundaries. Complete the dialog box as shown in Figure 12. 
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Figure 12 Plotting vapor fraction lines along with the cricondentherm dewpoint 

 

3. Click OK to continue. CHEMCAD perform the required flash calculations to generate the 

specified phase envelope. Phase envelope results are produced in two formats: 

 

• A numerical tabulation (table) of the temperature, pressure, vapor fraction, vapor 

compressibility factor, and the liquid compressibility factor 

 

• A graphical plot of temperature and pressure for each vapor fraction line requested The 

tabular results will appear first; since you’re interested in the graphical results, close the 

window displaying the table. The screen will now look similar to Figure 13. Note that the 

main CHEMCAD button toolbar is largely unavailable now, and the menu items have 

changed 
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Figure 13: Phase envelope plot results 

4. To determine whether the cricondentherm dewpoint of stream 5 is 20 °F or less, zoom in 

on the far right portion of the dewpoint curve. To do this, click and drag with your mouse to 

highlight that portion of the graph— approximately 400 to 1000 psi and 0 to 30 °F. When 

you release the mouse button, the selected area will fill the entire plot window, giving you a 

closeup view of specific data points. 

 
Figure 14: Zoomed-in plot result 
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5. As this view shows, the highest dewpoint of this mixture is a little less than 20 °F, so the 

cricondentherm dewpoint is indeed within the target product gas specification. Right‐click 

the mouse anywhere in the plot window to return to the full plot view. 

 

6. To print the phase envelope plot, click the Print button and then follow any prompts from 

your printer. 

 

7. You can also try the following to practice working with plots in CHEMCAD: 

• Edit the text of the plot title (in this case, Phase Envelope for Stream 5) or the graph axis 

labels by selecting Chart > Edit Titles. In the Chart Titles dialog box, make any desired 

changes and then click OK to view the updated chart. 

• Select Chart > Edit to open the Chart Explorer, which provides access to settings for color, 

size, layout, and various other aspects of the plot presentation. 

 

8. Return to the main simulation window by clicking the chart tab’s red x button, or leave the 

chart window open and click the main simulation tab at the bottom left of the CHEMCAD 

workspace. 

Checking the Bottoms Stream Purity 

This problem also requires that the percent of propane in stream 9 be 1%. You can check to 

see if you’ve achieved this specification by checking the stream composition report available 

on the Report menu. First, though, you’ll need to set the flow units for the stream 

composition. 

1. Select Report > Set Flow Units to bring up the View Flow Rate Unit dialog box. Click 

the Mole % button and then click OK to apply this selection and close the dialog box. 

2. Now select Report > Stream Compositions > Select Streams. In the Select Streams 

dialog box, type 9 and then click OK to continue. 

3. The resulting tabular data window shows that propane is greater than the 1% specification 

(see Figure 15). This means that the initial design is too conservative. To correct this, you 

can go back and re‐specify the column to produce precisely 1% propane in the bottom. 

 
Figure 15: Stream Composition report for stream 9 
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4. Return to the main simulation window by clicking the report tab’s red x button. 

 

Re-running the Simulation 

You can now re‐run the stabilizer, specifying that you want 1% propane in the bottom. 

 

1. Double‐click the Tower UnitOp to bring up the TOWR Distillation Column dialog box for 

the stabilizer. 

 

2. Click the Specifications tab. You need to change the reboiler mode from 4 Bottom mole 

flowrate to a purity specification. Click the Select reboilers mode drop‐down list and select 6 

Bottom component mole fraction. 

 

3. With this change of mode, you need to specify the desired purity and the component for 

which it is being specified. In the Specification field, enter .01. In the Component drop‐down 

list, select 4 Propane. 

 

4. Click OK to save your changes and return to the main CHEMCAD workspace. 

 

5. You can now re‐run the calculations for the condensate stabilizer. While you could 

accomplish this using the Run All command, it’s more efficient to rerun only the UnitOp that 

you have changed. The quickest way to do this is to right‐click the UnitOp icon on the 

flowsheet and select Run this UnitOp. Run the Tower UnitOp using this method. 

 

As soon as you see the Run finished message in the bottom left corner of the CHEMCAD 

window, you can check on the propane content of the bottom stream. You’ve already seen 

how to get a detailed Stream Composition report; you can also use the Flowsheet Quickview 

feature to get instant stream information without even clicking the mouse. 

  

Find the Flowsheet Quickview button at the far right end of the CHEMCAD toolbar. If this 

button is not currently activated (with a thin outline and a white button background), click the 

button to turn on this feature. 

 

 
 

Figure 16: Turning on the Flowsheet Quickview feature 

 

With Flowsheet Quickview turned on, point your mouse cursor at stream 9 on the flowsheet. 

After a moment, a pop‐up information window appears, listing stream properties including 

composition. The value for propane should be 1 or very close to 1, as shown in Figure 17. 
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Figure 17 Checking the propane content of stream 9 

 

Now that you have achieved the results that you set out to produce, save the simulation, using 

either File > Save or the Save button on the toolbar. 

 

Producing a Text Report 

The Report menu offers a broad array of text reports, as described in Chapter 8, Output and 

Reports. For the purpose of this tutorial, assume that you want to view and print out a report 

with the following information: 

 

• For Streams 1, 5, 8, and 9, the stream composition in mass flow rates and mole fractions, as 

well as the default stream properties 

• The equipment summaries for every piece of equipment in the flowsheet 

• Tower tray profiles for the condensate stabilizer 

 

Because you want a report with a broad range of information about your simulation, use the 

Consolidated Report option. 

 

1. Select Report > Consolidated Report to bring up the Report Writer dialog box. From 

here, you can specify exactly what you want to include in your report. 

 

2. Start by specifying which streams you want to include. Click the Select Streams & 

UnitOps tab and check the Select Streams (Override Defaults) box. This provides access to 

the other stream selection settings. 

 

3. Click the Select From Flowsheet button, which brings up the Select Streams dialog box. 

Either type in the numbers 1, 5, 8, and 9 or click the corresponding streams on the flowsheet 

to add the numbers. Click OK to return to the Select Streams & UnitOps tab. 
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4. The All UnitOps option is selected by default. In this case, you do want to include all 

UnitOps in the report, so leave the settings on the right side of the tab as they are. 

 

5. Click Stream Properties in the left column to view the stream properties options. Then 

click the Properties tab, which lists a collapsed list of all available stream properties. You 

can check the Stream Properties (Override Defaults) box to explore the various properties 

and see which ones are selected, but for the purpose of this tutorial, use the default settings 

on this tab. 

 

6. Click Stream Composition in the left column to view the stream composition options. 

Then click the Stream Compositions tab, which lists available and selected flow options. 

Click the Stream Composition (Override Defaults) box to gain access to these options. 

Keep the Mass Flow Rate option, and double‐click Mole Fractions in the left column to add 

this option to the list of selected flow options at right. 

 

7. Finally, verify that the Tray profile report section is included in the Consolidated Report. 

You can also delete any report sections that you don’t need, and re‐order the desired sections 

to suit your needs. 

 

8. Click Generate to run and display the report. You can now review the results, re‐run if 

desired, save the report for later use, and print the report as needed. 

 

9. When you finish reviewing and working with the report, click Cancel to close the Report 

Writer dialog box and return to the main CHEMCAD workspace. 

 

Generating a Process Flow Diagram 

As you know, the streams and UnitOps on a flowsheet only tell part of the story of your 

process. Fortunately, CHEMCAD provides many features to help you add the extra content 

needed to turn a plain flowsheet into a full‐fledged process flow diagram (PFD) for others to 

review and use. 

 

To prepare your finished simulation to be printed as a PFD, you’ll add a stream databox 

containing the heat and material balance for the entire flowsheet. You’ll place that databox 

underneath the flowsheet diagram and then add a title to the area above the flowsheet. 

Finally, you will create a new layer in this simulation and assign the PFD‐specific items to 

that layer, so that you can hide them from view 

when working and display them again quickly for printing. 

 

Follow these steps to prepare and print the PFD: 

 

1. Start by zooming out to give yourself more workspace. If you use a mouse that is equipped 

with a scroll wheel between the mouse buttons, you can point at the center of your flowsheet 

and roll the scroll wheel down a few clicks to zoom out. If you don’t have a scroll wheel, you 

can select View > Zoom Options > Out. 
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2. Now place the databox containing the heat and material balance for this flowsheet. Select 

Format > Add Stream Box to bring up the Select Streams dialog box. Because you want to 

include all streams, leave the settings the way they are and click OK to continue. 

 

3. In the Databox Property Options dialog box, review the default selections, indicated by 

checked boxes. For the purposes of this tutorial, leave the selections as they are and click OK 

to continue. 

 

4. In the Databox Settings dialog box, you can indicate whether to use dividing lines within 

the box. Accept the default settings here and click OK. 

 

5. The stream databox appears in the upper left corner of the CHEMCAD workspace, but you 

want to place it below the flowsheet. The databox is already selected, so point your mouse 

cursor anywhere inside the box and then click and drag to reposition it. Move the databox 

until it is centered below the flowsheet diagram. 

 

Note: You can also resize a databox by selecting the box and then clicking and dragging any 

of the sizing handles at the corners. Drag in to make the databox smaller, or out to make it 

larger; notice that the text adjusts in size to fit the box. 

 

6. Now place a title on the PFD to describe the process. In the All UnitOps or Drawing 

Symbols palette, find and select the Text tool. 

 

7. Move the cursor to a point somewhere above the flowsheet and click the primary mouse 

button. A vertical insertion point line begins to blink where you have clicked. Type the words 

Condensate Stabilizer PFD and then click any blank spot on the CHEMCAD workspace. 

 

8. To make this text larger, select Format > Font. In the Font dialog box, change the Size 

setting to 18 and then click OK. 

 

9. Click and drag the new heading to center it above the flowsheet diagram. 

 

10. Finally, set up a layer for your stream databox and title so that you can display or hide 

these items as a single unit. At the bottom of the CHEMCAD Explorer pane, click the 

Simulation tab, then right‐click the Layers item and select New. 
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Figure 18: Creating a new layer using the CHEMCAD Explorer 

 

11. In the New Layer dialog box, type a name for the new layer. For this example, name the 

layer PFD Elements, then click OK to create the layer. 

 

12. Now add the two PFD elements to the layer. Click the title that you placed above the 

flowsheet, then hold down the [SHIFT] key and click inside the stream databox that you 

placed below the flowsheet. Both items should now be selected, with small black boxes 

visible in each corner. 

 

13. In the CHEMCAD Explorer pane, double‐click the Layers item to expand it, then right‐
click on your newly created PFD Elements layer and click Add Selected. 

 

 
Figure 19: Adding selected items to your new layer 
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14. The title and stream databox are now part of the PFD Elements layer. This layer is 

visible, as indicated by the green check mark on its icon. Click this icon or the name PFD 

Elements to toggle the layer off, causing the title and stream databox to disappear; then click 

again to make them visible. 

 

15. With the PFD elements visible, select View > Zoom Options > Zoom to Fit. This 

custom‐fits the entire PFD to the available workspace for optimal printing. To print, you can 

either select File > Print or click the Print button on the main CHEMCAD toolbar. Follow 

the prompts for your printer tocomplete the printing process. 

 

16. To close CHEMCAD, select File > Close, or click the Close button in the upper right 

corner of the CHEMCAD window. Click Yes at the message asking whether you want to exit 

CHEMCAD, then click Yes again to save changes to the simulation. 

 


